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From the Chief Editor's Desk
Well, dear readers, this is our first anniversary issue, number 12. It's
a milestone that makes me very proud to have been part of this
project. But I didn't do it alone. There are a lot of great people
"behind the scenes" that work all month to make this magazine
possible. Over that past year we've gained some and lost some, but
the project continues -- as it should.
Might I suggest that you take a moment to read through the list of
contributors, graphics artists, editors, proofreaders, coders, etc?
Then visit the main forum and PM someone from that list and tell
them how much you appreciate their hard work.

And it IS hard. We spend a lot of time scouring the main forum and
other sources for article material. Then someone writes the article
and the proof/edit process starts. It takes two weeks of emailing
articles around the world (literally - we are spread from China to USA,
to England, to Australia), to get them in clear, readable language that
anyone, new to Linux or old timer, can read and enjoy.
Then the articles are sent to layout and prepared visually. That, of
course, includes the great covers we've brought you each month.
Each one is a creation by our graphic staff, not just some free clip art
we grabbed somewhere.
And this month we continue the tradition with thirteen articles on a
wide range of topics, including our ongoing KDE User Guide.

---

Tim Robinson

Starting with the September Issue, Papawoob will take over as Editor
in Chief. Because of health problems, I am stepping down from that
position. I'll stay on as an editor and occasional writer. It has been a
great year and I've learned a lot and developed some strong
friendships. I'll still be here, and readers should feel free to email me
as previously, but Papawoob will handle the "Letters to the Editor" in
future.

PCLinuxOS 2007 FINAL Released
Written by Texstar, Sunday, 20 May 2007
Texstar and the Ripper Gang are pleased to
announce the final release of PCLinuxOS 2007.
Featuring kernel 2.6.18.8, KDE 3.5.6, Open
Office 2.2.0, Firefox 2.0.0.3, Thunderbird 2.0,
Frostwire, Ktorrent, Amarok, Flash, Java JRE, Beryl
3D and much much more. Almost 2 gigs of software
compressed on a single self bootable livecd that can be
installed to your hard drive provided it is compatible with your
system and you like the distribution. Over 5000+ additional
packages available after hard drive install through our Synaptic
Software Manager. Please note PCLinuxOS does not ship with
Win32codes or DVD decryption software. Proprietary Nvidia and
ATI drivers available after hard drive install.
In addition we'd like to give out a special thanks to the
PCLinuxOS community who stepped up last month to help us
out and kept us going. Thank you for all your support and we'll
keep working hard to bring you a good Linux distribution you
can be proud of. We also want to thank Enki Consulting for
providing hosting for our website and ibiblio.org for hosting
our distribution.
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Lessons From Children
by Merlin Whitewolf

Recently, my son and his family moved. They had bought a house
and were moving into it as first time home owners. I offered to help
and made the drive there to give what assistance I could. My
daughter-in-law assigned me the job of “designated babysitter” and
refused to allow me to do any heavy lifting. She's a very wise woman.
To be a babysitter means that you must watch out for and take care
of children, but it often turns out that they're doing as much for you
as you do for them. That was the case for me when I decided to have
my granddaughters, ages 10, 8 and 5, learn to use Gimp as a way to
entertain them during the move. I have no delusions as to the skill
with which I can create graphics. I know next to nothing of this
marvelous skill, but I chose to use this as more in keeping with
catching the interest of the young.

The 8 year old granddaughter started off. That is, on the morning we
started this, she was the first out of bed after me. When her sisters
awakened, she was almost done with the wallpaper that she made.
This is how things proceeded, as near as I am able to remember:

We opened Gimp and chose “New” and 1600 by 1200. Next she
chose a color. I had thought that color choice would be a fairly simple
thing, but it isn't really so in every situation. When you're adding
effects to it, your color choice may need to be changed as the effects
you're going for may alter the color in a way that you do not want. Or
as she put it, “That makes the color different. We have to use another
one.”
Choosing which effects and how to apply them was another lesson
for me. The way an effect behaves by default is not necessarily how
you want something to appear, so you look for and apply changes
until you get what you want. The “undo” under the “edit” menu saw a
lot of use as first one color and then another and as first one effect
and then another was chosen.
Finally she announced, “That's it, Popa. It is the best we can do.”
On the next page is the wallpaper she created:
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After a long day of moving household items and of course, playing,
my youngest granddaughter took her turn at graphics creation. At 5
years old, she is an amazing artist. She was very decisive about which
colors to choose and where and how they were to be used. The only
difficulty she had was in having Gimp to show the color choices that
she wanted. I learned a lot from her about making slight alterations
in the color choice menu to get just the right shade of color and the
right amount of light or darkness to each color.
Her wallpaper was created in the shortest amount of time. In part,
that may be that she had already seen how her sister had made
choices, but it is also that she has a natural ability to create art. That
is my firm belief.
On the next page is the wallpaper that she created:
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It has what might be termed a typical 5 year old's 'in-your-face' look,
yes, but take a closer look at it. In the main field there are subtle
squares of light and dark. In the center there is an eye. The pupil of
the eye is a striped egg of many colors. She created three levels of
artistic effects in one picture. Each could be taken to be a single
creation, but she chose to combine them into one and thus made a
more 'advanced' creation. I found this to be very impressive.

Last, but definitely not least was my oldest granddaughter. She took
longer than the others to create her graphic. She chose first one
combination of color and effect and then another. The “undo”
function was used more in her efforts than those of her sisters. When
something didn't work for her, she was ready to try another choice.
She went through several effects choices for each color before she
would change to a different color.

It might be said that she had a hard time making up her mind. I think
that she was wanting to see how an option would look before she
decided if it was a keeper or not.
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This is the wallpaper that she created:
She took her time in choosing this exact shade of blue and the exact
width of each turn of the spiral.

Stare at it for a moment. Do you get the sensation that a subtle
movement is going on? What else might you see there? Think on it. A
10 year old chose to create this effect.
My granddaughters are eager for me to return for another visit. I
must bring my laptop, of course, as they want to create more
graphics. I wonder what they will create next?

Letters To The Editors
I have PCLinuxOS loaded on my 2GB memory stick so it loads from
there on ANY PC! I just tried it on my basic laptop and found that
configuring the built-in Broadcom wireless card was a breeze. I had
previously put the Broadcom BCM43xx files in a folder on my
windoze partition which were accessible from root. Using the tools in
PCLinuxOS I simply had to type in the WEP key for my wireless
modem/router (a Netgear device) and hey presto! The blue wireless
LED came on and I am in touch with you. I just have to work out how
to save the settings to my memory stick. Just wish a few more games
were in the setup by default. Will try the 2007 version soon.
Morrison H

Thanks a lot for your feedback, Morrison. Try PCLinuxOS 2007 Final soon.
I'm sure you will be pleased with the changes and improvements that have
been made since previous versions.
Tim
Hello all,

As a relatively new Linux user (12 months), I have tried many distros
starting with Ubuntu, and then went onto experiment with Fedora,
Sabayon, Sam just to name a few. I came upon PCLinuxOS just by
accident and wow am I impressed. Whilst the 'community' is not as
robust as the Ubuntu community the product speaks for itself.

I keep other distros on my system but now rarely even go to them as
PCLinuxOS does it all with gusto!
Thanks to all the developers for a great product!
Tony C

Tony, thanks for those kind words. I'm sure Texstar and the rest of the
developer appreciate hearing such praise.
Tim
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Great Magazine!!! I'm a Linux noob and found these articles VERY
helpful/informative. Keep them coming!
Steve B

Thanks, Steve - we will.
Tim
Hi,

I am an entirely 100% newbie to Linux and wish to both thank you
and compliment you on a job well done. Having absolutely zero
experience with Linux I am presently trying to go through that oh so
painful part of trying to figure out what Linux is all about. The part
where you choose a distro to use to see if you can actually like Linux
and make it work. I've downloaded nearly 50 different distros in the
last couple days to burn to CD and then try at my leisure to see if I'm
totally stupid or can convert to Linux. PCLinux was the very last one I
downloaded.
While it was downloading I was also trying to make copies of any
pertinent paperwork that might apply. Manuals, FAQs, etc, to make
things easier as I start out. In the process I came across the link to
the PCLinuxOS magazine for July 2007. Lord Bless you for all the
wonderful information you included in that issue. I honestly can say
that after reading that one magazine I now know more about Linux
and how it operates than after nearly 3 months of seeking
information online. And it was written in a manner that made it easy
for me to understand without making me feel like a total idiot or
speaking down to me.

In my mind, the single greatest sin of any computer user is that we
forget that at one time or another each and every last one of us was a
"NEWBIE" that was begging for help to understand this great new
world of computers. We look down or speak down to those newbies
like we are God and forget at one time they were us. In your
magazine you do not do this and for that I cannot commend you
enough. You also have achieved that wonderful ability to be able to
write articles that are both helpful to the new and the more wiser and
knowledgeable Linux user at the same time. That ability is almost a
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God given gift that few of us ever are capable of. Cherish it. And keep
right on using it to help those like myself learn about Linux and the
great wonders it promises to come. Only good can come from wise
use of that gift like you are doing now.
I was brought up on Microsoft Windows from the very first when DOS
came out. It is like anything else. A learning experience. And what
you learn is learned through years of effort in the computer world.
Your magazine and the way it is written takes years off that learning
curve for so many and in so many ways I cannot begin to list them
all. But this I can tell you. After reading this one copy of your
magazine I probably have taken at least 2 years off my learning curve
of being able to operate a Linux based computer. That is saying a lot.

It has been years since anything gave me that boyhood thrill to see or
receive. Your magazine is the first thing in so many years to do that I
can't even believe it. I actually sat here and read the entire magazine
page by page until I was totally finished. I didn't skip one detail
anywhere in it. It was like one of those thriller books you get into as a
young man or woman that grabs you and you can't sit it down until
totally finished. And I can't wait to go back and download all the rest
of those available back copies you have on your site. I'll probably be
up all night long reading your magazine from cover to cover in each
issue.

You not once tried to cram something down my throat the way
Microsoft has begun doing to their customers. Not once did you try
to tell me in certain ways that I wasn't smart enough to know what I
want or need on my own computer like so many of the Microsoft
crowd do nowadays. And don't get me wrong, I love Windows and
how it operates. Except for the security issues that is. And the price
of the software you really need. But those issues aside I really do
enjoy Windows. However, when Microsoft began forcing people to go
out and totally rebuild or replace their computers every three years it
began to be to expensive to use Windows. When they began to force
people to change operating systems every three years it became to
expensive. And when they started forcing people to go out and buy
all new software every three years to go with the new computer and
the new operating system because they made the new stuff refuse to
work with any of your older software it became to expensive. VISTA
became the last straw for me. It is nothing but eye candy for Windows
XP and yet they try to force me to replace all my Microsoft Office
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applications at hundreds of dollars each to go with it. That was when
I knew I had to do something else.

And lo and behold there was Linux. I had tried it just as little as
about four years ago and could make absolutely no sense of it at all
back then. Now Linux has progressed to the point where many
distros look and operate very similar to Windows. AND IT DOES IT
FOR FREE. PCLinux seems to be one of those distros that does exactly
that. It appears at the onset to be one distro that will allow a newbie
like myself to make that last jump from the Microsoft sinking ship.
And I don't think I'll need a four year course at a college to be able to
do it. Many Linux flavors today even have the new 3D GUI that
Microsoft says can't be duplicated in any Windows operating system
except Vista.
So from the bottom of my heart I wish to thank all of you both at
PCLinux and at the PCLinux OS Magazine for assisting me in being
able to finally learn and be able to use Linux at home in a
constructive manner. I, my wife, and my daughter all have our own
desktop computers. My daughter and I both have laptops also. And
on top of all that I have been trying to figure out how to afford to set
up at least one if not two file servers to keep all our important
information on in a safe manner. Plus we have been interested in
setting up a new media center edition of a computer for all our
shareable files and movies and music etc. The Microsoft cheapest
server software is hundreds of dollars per copy plus operating
systems to go with each. Not to mention the individual computer
copies of all the various software we use and need each day. Linux
can basically save me literally thousands of dollars just maintaining
my own home computers.

Not to mention the horribly hard part of trying to teach my daughter
and wife a completely new way to use computers without Windows.
PCLinux appears to nearly take all that effort away overnight. And I
dreaded that part the most. You have lifted a horribly heavy burden
off my heart with PCLinux and your magazine. Even my daughter who
is extremely ADHD and has tremendous times trying to learn new
things can understand your magazine. It explains things to her in a
way even she can understand and be able to make sense of again
without making her feel like someone is talking down to her. We
cannot thank you enough for that.
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I've taken up enough of your time and will let you go now. Just
wanted you to know that what you do is good, that it succeeds where
so many others totally fail, and it is so clearly appreciated by so many
of us. Give yourself and your team one great big pat on the back.
God Bless and thank each and every one of you.
Sincerely,
Allen W

Thanks for the kind words, Allan. All the staff work hard during the month
to provide articles that are fresh, informative, and in language that those
new to Linux, as well as "old-timers" can deal with. Be sure to check out
some of the back issues. I'm sure you will find more useful information
there as well.
Tim
First and Foremost Hello to all and congratulations on PCLinuxOS!

Here's a little background to my story. I live in Greece and I have
been using Linux since 1997. I started with SuSE version 6.0 and had
kept updated my lowly PII all the way to version 10.2 of Open SuSE. I
was not very happy when I upgraded to 10.2 and lost the ability to
use arecord.
A small thing huh?

Anyway, this summer my son and I are visiting my parents in Spring,
TX. I should also mention that my 17 yr old son is probably better
versed with Linux than I am. My parents asked me to take a look at
my mom's computer (PIII with 512MB). When she logged on to her
Windows XP box she had to get up and leave for about 10 minutes
while the silly thing connected to the Internet. I tried installing SuSE
10.2 on the box but it just kept freezing at odd moments and the
response of the computer was not really satisfactory. I then tried
Ubuntu but it could not configure the Riva 128 video card properly.
So far Linux was 0 for 2.

While I was working on this, my dad was busy spoiling my son with a
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new laptop. Since we don't have a decent LUG in our neck of the
woods in Greece we decided to take a trip to the Houston LUG and
see what kind of information they might have for us. While we were
there one of the users brought over a CD of PCLinuxOS final and I
tried it on my son's new laptop. Impressive.

When I got home I installed it on my mom's box in less than 30
minutes. I updated the box over night and viola! It works like a
champ. No setup problems, no vim /etc/X11/xorg.conf, no vim
/etc/fstab. It found the USB wheel mouse (SuSE didn't) and the USB
flash drive that I had forgotten to remove was also set up
automatically. It even set up the rinky-dink HP multi-function ink jet.
I really liked the touch with the NTP daemon. This distro is just great.

My parents were really impressed since they had been prepped by the
windows propaganda to buy a new computer. I am now teaching my
mom how to use Open Office, Evolution and Firefox.
The only thing I have left to do is set up a backup job in cron and see
about doing a little better job with filtering spam. I would be
interested in hearing how other users have set up their mailing
systems.
Well I think I have about used up my word count.
Thanks again,
Rod C

Thanks for the feedback, Rod. It's always great to hear about people's
success with our favorite Linux distro. When you return to Greece, why not
try to start a LUG there? Happy computing.
Tim
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CHAPTER 7: MULTIMEDIA GRAPHICS ACCESS
Multimedia Access and Players

Apart from being able to view and create graphics and other images,
the PC is capable of supporting a wide range of audio and video
features and facilities. These include the playing of audio CDs, audio
digital files, VCD and DVD as well as multimedia games.

Note:

While support may be available in the software, the necessary
hardware has to be available before these multimedia facilities can be
used, e.g. a DVD drive is required to be present on the system before
you can play a DVD.
By default most modern PCs come with a CD-ROM drive capable of
playing audio CDs and VCDs as well as a sound card and speakers.
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As such in this chapter we shall discuss how you can listen to an
audio CD, play audio digital files and view VCDs.

In the following sections we shall be discussing several media
players. Some of these e.g. mplayer and xine are multimedia players
in that they can be used as generic players for audio CD, digital audio
files, VCD and DVD.

THE VOLUME CONTROL APPLET

Since almost all the multimedia applications require some form of
audio production and mixing, it is useful if we know how to control
the various channels of audio available from the sound card using the
Volume Control Applet on the Panel. This may be launched by rightclicking the Volume Control icon on the Panel and selecting Open
Volume Control. If it is not there you can also launch it form the Main
Menu:
Main Menu -> Multimedia -> KMix

Fig. Volume Control Applet
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Kmix is essentially an audio mixer which enables you to mix the
audio for a 2-channel sound card. Every mixer control that your
sound card provides is represented by a volume slider. Mono controls
always have a single slider while stereo controls can have either one
or two sliders, depending on your settings. There is also a panning
slider at the bottom of the window. If your system has more than one
sound card, a list will be displayed at the top of the window.
The Kmix window can have up to three different sections, Output,
Input, and Switches. Each section will contain volume sliders,
switches for enabling/disabling record or playback functions, and
multiple choice selectors.
Output: This tab holds the controls that are most likely related to
playback, like the Master volume control.

Input: This tab holds the controls that are most likely record related,
like Capture.
Switches: These controls allow you to switch certain functions On
and Off, like External Amplifier.
Kmix also features LEDs. The general coloring rule is as follows:
Green: An LED dealing with playback
Red: An LED dealing with recording
Yellow: An LED dealing with special sound card capabilities
A lit LED means On, a non-lit LED means OFF.

In most situations the volume can be adjusted by clicking on the
Volume Control applet on the Panel and raising or lowering the slider
accordingly.

PLAYING AUDIO CDS

You can play an audio CD by placing the CD into the CD-ROM drive.
The CD player application (KsCD) will be run automatically to play the
CD. Ensure that your speakers are turned on so that you can hear the
CD! You can also manually start the CD Player application from the
Main Menu:
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Main Menu -> Multimedia -> Sound -> KsCD

Fig. CD Player

You can control the CD Player just like a normal CD player with the
buttons shown on the CD Player screen. These include volume
control, track forward/backward, play/pause, stop, eject as well as
jumping to any track on the CD directly.

PLAYING DIGITAL AUDIO FILES

PCLinuxOS gives us Amarok which is arguably the most complete
music manager available today. Amarok serves many functions rather
than just playing music files. For example, Amarok can be used to
organize a library of music into folders according to genre, artist, and
album, can edit tags attached to most music formats, associate
album art, attach lyrics, and automatically "score" music as you play it.

Fig. Amarok
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Amarok plays media files in various formats including but not limited
to (depending on the setup), Flac, Ogg, Mp3, AAC, WAV, WMV, and
Musepack.

Note: Amarok will not play digital music files protected by DRM, such
as those purchased from the Itunes Music Store.
It also can Sync, retrieve, play, and upload music to digital music
players, such as Ipods or Creative Zens.

Note: To work with Creative Zens or other MTP devices, libmtp0 will
need to be installed from the repositories.

One last notable feature is Last.fm support, including submitting
played tracks (including those played on some digital music players)
to Last.fm, retrieving similar artists, and playing Last.fm streams.
You can find Amarok by going to:

Main Menu -> Multimedia -> Sound -> Amarok

Another excellent player that is in the repositories and can be easily
installed is XMMS. The XMMS (X Multimedia System) application can
be utilized to play a wide variety of digital audio file formats. These
include the popular MP3 as well as the open Ogg Vorbis formats. To
launch XMMS, (after it is installed) select:
Main Menu -> Multimedia -> Sound -> XMMS

Fig. XMMS Player
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Note: XMMS may need additional plug-ins to be able to play some of
the audio file formats. If these are not already installed on your
system they can be installed from the repositories using Synaptic.

You can control the XMMS player using the graphical knobs and
buttons displayed. In addition, you can select the source of the audio
files to play. To do this, right-click on the XMMS player and from the
pop-up menu select "Play File" to select the audio file to play. If you
want to be able to play an audio file from the Internet select "Play
Location" and enter the Internet location of the file.

PLAYING VCD AND DVD

There are several excellent applications readily available for you to
use to play VCD and DVD media. Here we shall look at two of them:
Kaffeine and Mplayer. These can also play CD and digital audio
music files.

K AFFEINE

The Kaffeine application may be used to play VCD and DVD. You can
start Kaffeine from the Main Menu:
Main Menu --> Multimedia --> Video -> Kaffeine

The Kaffeine user interface is highly intuitive as it resembles a normal
VCD/DVD player with all the basic control knobs and buttons.

Fig. Kaffeine Control Panel
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To play a VCD, place the VCD into the CD-ROM drive and click on the
Play VCD button on the Kaffeine control panel.

To play a DVD, place the DVD into the DVD drive and your movie
should start playing. If it does not then right click on the DVD icon on
your desktop and choose "Play DVD with Kaffeine."

The volume control can be adjusted by clicking on the volume control
button.
Kaffeine is a very powerful multimedia application with many
features. It can also play audio CDs as well as digital audio files.
Note: to be able to play encrypted DVDs you will need to install
libdvdcss and win32codecs from the repositories using Synaptic. You
will need to check to see if the use of these libraries is legal as it is
considered illegal to use this in certain parts of the world.

MPLAYER

Mplayer is a popular movie player for Linux. In addition to being able
to play VCD and DVD it is also able to handle a wide variety of audio
and video files and streaming data formats. Hence it is useful to use
Mplayer as the universal multimedia player. The Mplayer GUI can be
started from the Main Menu,
Main Menu -> Multimedia -> Video ->MPlayer

On start up, the main Mplayer control screen and the Mplayer video
output screens are displayed.

Fig. Mplayer Control Screen
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Fig. Mplayer Video Screen

The control screen enables you to control the operations of Mplayer
while the video screen displays any video that is being played. In
addition, right-clicking with the mouse when it is inside either the
control or video screens will also bring up a menu for controlling the
use of Mplayer.
The Mplayer control screen enables you to perform the following:
•
•
•
•
•
•
•
•
•

start, stop and pause play
go to the next and previous stream
jump to the first and last tracks
adjust the sound balance
adjust the volume and mute
select files to play
set up a playlist
set the video and audio equalizer
configure preferences
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• exit the Mplayer application

All of the functions are represented by intuitive knob, dial, and
button icons on the control screen making it very easy to use Mplayer.
To play a VCD, place the VCD in the CD-ROM drive, move the mouse
over the control screen or video screen and right-click it. Select,
VCD -> Open disk
To play a DVD, perform the above for VCD but instead select,
DVD -> Open disk

The size of the video screen can be controlled by right-clicking on
the mouse and selecting normal size, double size or full screen.
When you are in the full screen mode, to return to normal size, rightclick on the mouse and select normal size.

EXERCISES

1.Play an audio CD using the KsCD Player
2.Play an audio digital music track using Amarok
3.Play a VCD or DVD using Kaffeine and MPlayer

GRAPHIC IMAGES ACCESS

Very often it is useful if we are able to view graphic image files on
their own, or in thumbnail fashion if there are many of them. It is
also useful if there are simple tools available which will enable us to
manage these image files, e.g. catalog and classify them and recall
them for viewing. In this section, we shall look at several tools
available on your system which provide some of these functionalities.

FILE MANAGER

The File Manager itself provides a simple and convenient means to
access and view image files. To view an image file from the File
Manager, move your mouse pointer over the file and a larger
thumbnail picture will appear. To view the file full size double click
on it. Another convenient way of viewing when you have a lot of files
in a folder is to select the "View Mode > Photobook" option from the
View menu selection.
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Fig. Photobook View in File Manager

This will result in only the image files present in the folder being
displayed. You can then select an individual image to view and also
perform zoom in or zoom out views.

DIGIK AM CAMERA ACCESS

Digikam is a simple digital photo management application, which
makes importing and organizing digital photos a "snap". The photos
can be organized in "albums" which are automatically sorted
chronologically. An easy to use interface is provided to connect to
your camera and preview images and download and/or delete them.
Digikam uses a folder on your file system as an album library,
meaning that every sub folder of this folder will be considered as a
photo album and displayed in the album list on the left side of the
main window.

Clicking on an album will start showing the thumbnails for the
images in the album. You can change the icon size to small, medium,
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large or huge from the magnify buttons in the toolbar. Right Clicking
on an item will give you a pop-up menu, using which you can view,
rename, delete, see the edit information, and add/edit comments of
the images. Double clicking on an item will open it up in the image
viewer.

Fig. DigiKam Photo Manager

To be able to use your digital camera with Digikam, connect the
camera to your computer, switch the camera to the image display
mode and turn it on. If your camera is detected as a mass storage
device (ex. sda1) a "New Medium Found" window will be displayed on
your desktop along with an icon. If this does not happen when you
plug your camera in and turn it on then you will need to setup the
camera model and port using the setup interface. Try and see if
Digikam can auto-detect the camera; if not, you can set the camera
model and port manually.
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Fig. Camera Configuration

Once you have the camera setup, go to the "Cameras" menu in the
main interface and you will see the camera listed in the menu (Note:
You can choose any title you like for the camera in the setup and this
title will be used in the "Cameras" menu). If you have more than one
camera, you can add them throughout the setup interface.

Clicking on the camera item in the menu will pop up a new Camera
Interface and this will connect to the camera, and thumbnails (if
supported by the camera) will be downloaded and displayed. You can
then select the images and download or delete them from the
camera. Downloading can be done by using the menu/toolbar
buttons or by dragging and dropping them onto an album folder or
any other folder that you choose.
Digital cameras nowadays store images on either a CompactFlash
card, SD card, or SmartMedia card. The camera internally makes sub
folders in these storage media which it uses to save the images.
Digikam displays these internal folder trees and also provides a
global virtual folder which shows all the images available in the
camera.
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When you open the camera interface for the first time the folders are
hidden and the contents of the global virtual folder are shown (i.e. all
the pictures in the camera). You can choose to see the actual folders
on the camera by unselecting "Hide Folders" in the "View" menu. This
will show the folders on the camera, the topmost folder being the
global virtual folder. Clicking on a folder will show the contents of
the folder in the thumbnail view.

Fig. DigiKam Camera Client

SHOWFOTO IMAGE

VIEWER

The showFoto image viewer is a powerful tool for viewing, and
organizing graphic image files. To start this application perform:
Main Menu -> Multimedia -> Graphics ->showFoto
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Fig. showFoto Image Viewer

VIEW

The simplest way to view an image is to double-click on the name of
the image and it will be displayed in full. You can also navigate to the
next/previous image as well as go to full-screen viewing. The Zoom
function can be used to zoom in or out of the image currently being
displayed. Click on the Folders button at the top of the screen to go
back to the thumbnail view. A preview of the image will be displayed
in the preview area if you just select the thumbnail.
One useful feature of showFoto is the slide show. After a folder has
been opened (File > Open folder), selecting View > Slide Show will
start a full screen slide show of the images in that folder.

IMAGE MANIPULATION

You can also manipulate the images under showFoto. Some
supported functions include rotation, flipping, resizing, and Blowup.
To access these functions select "Transform" from the menu bar at
the top. Additional tools for working on your graphics files can be
found under the Fix menu.
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CONVERT FORMAT

The Save As function of showFoto allows you to convert your image
files from one format to another. Some of the 14 supported formats
are:
Portable Network Graphics (PNG)
Joint Photographic Experts Group (JPEG, JPG)
Tag Image File Format (TIFF)
TARGA format (TGA)

To use the Convert function, select an image first and then from the
top menu bar, select,
File -> Save As

and choose whichever format you would like to save to from the drop
down list.

HELP

showFoto has many other useful features. The online help guide
should be consulted for more details on how to use showFoto.
showFoto Handbook

EXERCISES

Use showFoto for the following:
1. View the images in the following folder:
usr/share/backgrounds/images
2. View a slide show of the images in the folder above.
3. Copy one of the images from the above folder into your home
directory and scale it down to 25% of its original size and save it.

MS Vista/Linux Dual Boot Tutorial
by Gimlet

Many people and I have discovered that the new MS OS Vista has a
new boot loader. Creating a dual boot system can no longer be
accomplished with the usual methods. Here is a solution that I have
found to be quick and simple.

If you are starting with Vista installed, do a volume defragmentation
using the Windows defragmentation tools. When the defragmentation
has finished, go to Start/Control Panel/Administrative Tools. Select
Computer Management, then Disk Management.

Fig. Disk Management window

Select your Windows hard drive with a right click and select "Shrink
Volume" from the sub menu. Shrink your partition to allow for your
Linux install. 2 gig swap, 10 gig /, and whatever you want for /home.
Close down all open windows.
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Fig. Shrink Volume

Download and install EasyBCD. It can be found at the link below:
http://neosmart.net/dl.php?id=1

Take your Linux Distro of choice (mine is PCLinuxOS) and do an
install. Follow the instructions. When you reach the point where the
distro asks you where you want to install Grub/Lilo, make sure you
tell it to install to /root. That means the partition you installed Linux
to. Make sure it is not installed to the MBR. When you are finished
your install, reboot.

Ok don’t be surprised when all you see is Windows rebooting. This is
where EasyBCD comes into play. Start EasyBCD. It should look like
this:
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Select Add/Remove Entries

Fig. EasyBCD

Then select the Linux/BSD tab on the bottom right. Now click on the
Type drop down menu and select the type of boot loader you
installed (Grub/Lilo). Next, give it a name in the name box.
(PCLinuxOS)

Now here comes the only part that confused me but, that happens a
lot. Look to the bottom left again. You will see two entries, Hard
Drive and Partition. In my case I have only one hard drive so the hard
drive is "0" and the / partition is "3." Here is why. Windows is on the
first partition, swap is the second partition, and root (/) was on the
third partition. So if you had two hard drives and Linux was on the
second hard drive and you setup the drive with swap first, then root,
then home, you would select hard drive "1" and partition "2." Click
"add entry" and you are done.
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Fig. Add/ Remove Window

Reboot Windows and you should be greeted with a black screen with
white text listing the two operating systems. Select the Linux entry
and you should see the Grub/Lilo boot loader. Select your OS and
away you go.
If for any reason you want to remove Linux and get your Vista boot
loader back, just fire up EasyBCD and select Manage Bootloader, set
your options, and click write MBR
I hope this is helpful. I am sure there are other ways to do this but I
have found this simple and quick. I have been using it for several
months with no problems.

A Simple Backup Method Using Grsync
by Iain Jackson (iainrj on PCLOS and MYPCLOS forums)

This article is a simple tutorial on using Grsync as a backup utility,
There have been a lot of threads on the main forum from users
asking for advice on backup and I have found Grsync to be the
simplest and quickest method around.
Grysnc is a GUI-front-end for the command line application rsync.
Rsync has many powerful applications, not least for synchronising
data to web servers. In fact rsync scripts are used by Texstar for
synchronising the repositories as new applications are added.

This short tutorial will show you how you can use Grsync to back up
your /home directory to either another hard drive, partition or
removable drive.

Your /home directory is where all your e-mails and bookmarks are
stored in hidden folders. To view them open home in Konqueror and
click on View|Show hidden files. Depending upon which applications
you are using you might see a .mozilla folder containing your Firefox
bookmarks and extensions; a .thunderbird containing your e-mails
and a .kde folder containing your desktop settings and settings from
KDE applications such as kmail.

1. INSTALL GRYSNC FROM SYNAPTIC.

Once installed, you will see the application under KMenu-->Internet->File Transfer. It might be a good idea to create a desktop icon for
easy access. To do so, right-click the icon in the k-menu and then
choose Add Item to Desktop:
2. a) If you want to backup to a removable medium such as a USB
flash drive or external USB drive, insert it now. When PCLOS detects
the drive, click on Open in New Window to mount the drive:

b) It is a good idea to create a new directory on your removable
disk to store the backup files. In your new window create a new
folder. As an example, home.backup is the directory name I use. To
create a folder, click on Edit|Create New|Folder.

Use the panel icon to go back to Grsync once your media is mounted.
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3. CREATE A BACKUP SESSION.

a) When you launch Grsync you will see this screen:
b) Click on Add in the Sessions section and enter a session name.
This is just so that once configured, you can quickly run the same
backup routine by choosing the session. Type something like “Home
Backup” and then click OK:

c) You now need to add your source and destination directories.
There are 2 blank boxes in the middle of the Grsync window. The top
box is the source - this is where your files currently are. The bottom
box is the destination - where you want your files backed up to.
d) Click on Browse next to the source box. This should take you
straight to your home directory. Just click on Open to select it:

e) Click on Browse next to the destination box. Your removable
drive should have appeared as a link on the left hand side of the file
dialog for easy access. Double-click it, then double-click on your
backup folder before choosing Open:

4. CHANGE THE BASIC OPTIONS.

a) It's probably a good idea to select Preserve Owner, Groups and
Permissions so that if you need to reinstate from the backup, you
won't get into any ownership problems.
b) Select Delete on Destination to ensure that you don't end up
with any old files in your backup that don't exist in your home
directory.

5. ADVANCED OPTIONS.

a) Check the Copy symlinks as symlinks box. This means that if
there are any links to files, only the link, rather than the file itself is
copied over.

b) Additional options are useful if you want to add other rsync or
console commands. The one I use is the exclude command. The
example below excludes the .thumbnails directory from the backup:
c) To find out all available rsync commands type man rsync into a
terminal.
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6. Do a “dry run”. Click on Simulation and you’ll get a quick run
through of what is going to be copied over.

7. When you are satisfied all the correct files are being either deleted
or copied, click on Execute. The first time you run the sync it may
take a while as it has to transfer all your data. The exact time will
depend upon the amount of data you are copying and the speed of
your computer. It might take 5-10 minutes to transfer your /home
the first time out, longer if you have a lot of large files such as audio
or movie files.
Subsequent syncs will be much quicker, perhaps 30 seconds, as it
only sends new or updated files for backup:

Grsync makes using rsync easy but doesn’t give you the full
functionality. If you want to have a go at creating scheduled backups,
you can write rsync scripts and use cron or Kcron to schedule the
tasks. Here’s a good website that takes you through that process:
http://www.mikerubel.org/computers/rsync_snapshots/#Rsync
For me, Grsync works a treat. About once a week, I switch on my
external hard drive, and run my 2 Grsync sessions - one for /home
and one for my data partition. The whole process takes about 5
minutes and I am safe in the knowledge if I need a clean reinstall of
PCLOS I have all my application settings, e-mails, bookmarks and
more importantly my music and photos backed up.

Not Everyone's Body is Unimpaired
by Heather

Summer arrived with a flourish here in my corner of the world. Its been a
hot summer so far, one I must admit I am enjoying very much, probably
because the other 11 months are full of snow. However, though my local
Pride Parade (a parade put on by our local gay community) got rained on
rather nastily, it didn't douse the spirits of the people present and
especially not the spirits of Steve, a friend of mine.
I don't see Steve often anymore since I don't go to the bar much now,
but when I did I often talked to him and danced with him when
possible. My girlfriend introduced us and she said she knew right off
I'd have no prejudices against dancing with someone with CP
(Cerebral Palsy) even if they were in a wheelchair or needed help
seeing their way to the floor. She was right, as she usually is, and
seeing Steve since then has been a joy because he is always smiling.
Seeing him this year reminded me that I have been meaning to write
something for this column that serves what I feel is an under-served
section of the community: those with various disabilities or needing
aid to use their computers in any way.
Certain people like Steve have less of an issue with their laptops and
desktops if they are reasonably able to use a pointing device, but
what of others? What about people who are deaf or hard of hearing
(HoH)? Having worked with deaf/HoH people for a year, I became
acutely aware of their issues many years ago. It seems their needs
are being met more and more but I have to wonder if this is true in
the FOSS community or just the commercial realm.

Then there are those who are legally or totally blind. Where do they fit
into all of this? How do they access what is, for all intents and
purposes, a very visual medium? GUI or command line, it will make
little difference to them which they use if they can't see what it is they
are trying to access. I've seen a couple of specialist distros that
address this (Oralux is the one I tried on my own desktop and I will
address it in another column if possible). I have become aware of tools
on the major DE's that can also help people who face these challenges.
However, I also admit my knowledge in this area is woefully inadequate.
Do such tools exist outside of the KDE/Gnome desktops?
Then we arrive at the people whose disabilities are more pronounced
than Steve's. People who, for whatever reason, are incapable of using
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a standard mouse or trackpad or trackball. There are those who can move
only their eyes or need to use a mouthstick. Where do they go and what
support can be offered to them? Is there specialized hardware available
for these people and if so where would one go to access such things?
Dare I even hope that the drivers used to tell these devices how to behave
on a standard Linux installation work on Linux at all? Where are the
developers doing the nitty-gritty work on these kinds of coding problems?

I'm sure I've missed some form of disability or some such thing in
there. This is why I am calling upon you, my loyal readers, to help me.
If it's possible for you to help me with this small series of articles, I'd
like your input on these issues! Write in, give me ideas on where to
look for information or name a distro you have tried that uses special
hardware or software to help those with disabilities of any kind. If you
cannot try a distro but want me (or someone I know) to try it out and
give a short synopsis of how useful it might be, write in! I'm looking
for readers to point out, as well, where things can be improved when it
comes to helping you use the technology we have available to us today.
Which companies are doing the R & D to solve these issues? Which
businesses have a decent headset for someone with very limited
mobility so she can use a head pointer to move a cursor around on the
screen? Is it expensive? Does it require special setup or knowledge to
set it up on the system? In other words, is it plug and play?

I know that the Debian distro has had, for some time now, EmacSpeak built-in and Braille drivers that allow the blind to use their
braille hardware with a regular computer using linux. Do you know of
any other distros out there that work extra hard to help all users
access their computer? Write in and tell us what you think of that
distro or ask us to review it if you like. Heck, review it yourself and
write us anyway! Most importantly I want my readers to write in and
tell me what they want me to address in the next few columns on the
subject of disability and Linux. I want to hear what you have to say
and I want to know what aspects of Linux you want me to cover so we
can, perhaps, help you to enjoy using your computer instead of
having to fight with it to get your tasks done.
Lastly if any of your friends or family wish to write in to point out
things we might look at addressing, please tell them to do so. We
are happy to receive such emails and I hope we can get to them.
With luck we will manage to address the issues they might bring up
too.

LinuxTracker, Torrent Seeding and Your Client
by John Coombe

BitTorrent files, colloquially torrents, are the most popular method of
sharing files among people all over the Internet now because it is
true peer to peer sharing. The servers do not host any files, only the
identifying files called tracking files. These are used to enable the
servers to keep track of who has what part of which file and to
allocate priorities to the packets being sent.

The LinuxTracker site serves huge numbers of distros' torrents and is
not exclusively for the use of PCLinuxOS. Because of the large
numbers of torrents that are active at any given time, it is not
uncommon for individual BT clients to not be able to connect to the
tracker sometimes due to the amount of traffic that the site
encounters 24/7 x 52 weeks/year.
Usually, if you go back and look at your BT client an hour or two
later, it will likely show something different.

An example of what is happening at the LinuxTracker (from bottom
of main page) - this changes all the time
Tracking 2,673 Torrents with 237,110 Peers (84,505 Seeders and
152,605 Leechers)
Current Seeder/Leecher Ratio (%) = 55%
Total Registered Users 25,080
Members Online (Now): 13 Members
Members Online (In last 24 Hours): 312 Members
Most Users Online: 594 Members on: 2007-04-20 08:15:41

So you can see it is not uncommon for several thousand torrents to
be active at any given time and just look at the numbers of
seeds/leeches. All of them have to communicate with LinuxTracker.
Due to this fact, it is normal that the SiteAdmin of this tracker (and
others) sets the time that the tracker sends out an update request to
each peer to around an hour. If the update request was made more
frequent than once an hour, the amount of network bandwidth would
be humongous, and he would have to pay for that. Also, if it was
made more frequent, it could act like a DOS (denial of service) for the
site. This aspect of busy sites is well known. There are some sites
where the update request has been set at 2 hours to reduce traffic.
If, due to the amount of traffic collisions, an individual BT client
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misses getting the update request, then you may have to wait for
another hour for it to happen again. It does not mean all the
seeds/leeches have vanished, it just means your BT client missed the
last update request.

Of course, this is for a torrent that is still active and has a lot of peers
using it and so lots of traffic. Eventually everyone downloads the
file(s) and has finished leeching. So all the seeds stop bothering to
continue to seed. Sometimes a torrent becomes what is called a dead
torrent, and if you try to download (leech), you fail unless a seed is
kind enough to restart for you! When a seed is 'dead' no matter how
long you wait, it will stay dead. Even if you get an update request
from the tracker you will never be able to connect to another peer
because there are not any left. When a torrent is dead, it is dead. :-(
A snapshot look at the torrent statistics at the LinuxTracker site
shows: 4712 completed 368 seeds 132 leeches. Another snapshot
look in 5, 15, or 30 minutes would show the number of
seeds/leeches higher or lower, depending on the traffic during that
time.
I hope that gives some sort of concept as to what is happening.
Our grateful appreciation to MyPCLinuxOS.com
and Devnet for making this project possible.

The PCLinuxOS
Hardware Database

A User's Story
On 6/10/07, s0l1dsnak3123 <s0l1dsnak3123@googlemail.com>
wrote:

First of all, I'd love to congratulate Texstar and his gang on their
amazing distro. It beats most commercial distros by quite a large
distance. I have tried many distros, including SimplyMEPIS, openSUSE,
Ubuntu, Kubuntu, and BackTrack, and I can easily say that this one is
the best.
Second, I'd like to thank you for this magazine, as it has helped me
understand many things about Linux. Linux is a complicated beast,
and I am proud to say that this magazine has helped me straighten
things out.

I am a 3rd year student at my high school, and I recently had a solotalk (basically a presentation) on Linux in front of the class. Many
people came up with different things, ranging from Elvis Presley to
Tom Crean. I chose Linus Torvalds (in part an excuse to advertise
PCLOS and Linux in general to my class). I used a Power Point
presentation with built-in videos of various functions and (of course)
the fanciest bells and whistles that Linux currently enjoys (Beryl, for
example). After I showed all of these videos, I showed a diagram I
had made of all the different parts of the desktop, noting the
transparency and handy features that other, more popular operating
systems lack. I showed how easy it was to change window managers
and presented some facts and figures on Linux's reliability, and
'customizability'.

My fellow pupils watched in awe at Beryl's beautiful effects. They
stared on at the customizations. However, I held one main factor to
the end. In fact, a pupil asked me before I got to say it... the price.
When I told them it was free, they didn't believe me. When my English
teacher asked what was the catch, and I said simply that there wasn't
one, nobody believed me still. When I told them about the GPL, they
didn't understand what was in it for the programmers, GFX designers,
etc. I told them that the main reason is because they want people to
use it, modify it, pass it on, freely, without any restrictions
whatsoever, and the only way for that to happen would be for it to be
free. By this time people wanted to know where to get "it", so I told
everybody the addresses for Distrowatch and PCLOS.
People now wanted to know how to burn the disk, but I had prepared
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for this question. I gave out copies of PCLOS TR3 which everyone in
my class took home with glee. I also gave them instructions on how
to start up the disk and install. My class has 20 pupils, 19 of which
own a computer. A couple of weeks ago, I asked how many people
had tried out PCLOS and 18 out of the 19 raised their hand. I asked
how many people used it weekly and I am proud to say that only 1
person put his hand down. That means out of 19 people who have
computers in my class, 17 use PCLOS weekly. Is that success or what?
I was thrilled to see my English teacher ask how to install PCLOS over
his Windows XP install. I think Linux will be a big hit in years to come.

A lot of my friends hated Windows Vista so much they reverted back
to XP. Remember, they aren't 'technical' per se, so they didn't know
about the performance problems, security problems, etc. While there
is a want for an alternative, the Linux community has a chance to go
mainstream. First things first though: we need to get rid of the jargon
and make Linux more friendly. When I say friendly, I do not mean so
that the average newbie will understand. We must remember that the
newbie knew how to search Google. He/she also knew how to post
on a forum. Many people I know don't even know what a forum is. I
also know many people who just use their OS for Runescape.
Linux must stay powerful, but become a more beginner-friendly OS.
Take the command line, for example. It is necessary in Linux, but
when was the last time the average user used the command line?
Probably never. Programs have the GUI built in. Compilers? I doubt
the average user knows how to compile a program. Some barely
manage installing a program in Windows with the installers such as
msi and NSIS. If the Linux community went through something as
drastic as this, it would mean a hell of a lot of work... but I believe it
would be worth it in the long run.
Just my £0.02,

John AKA s0l1dsnak3123
regards,
John

Installing and Using Peerguardian on PCLinuxOS

INSTALLATION AND FIRST USE

Privacy is a big issue in the online world. Big money is made selling
our personal information. For those who frequently download using
Peer-to-Peer programs, Peerguardian might be a good addition to
their system.

Peerguardian runs in the background of your system and is silently
blocking a large range of IPs that have been known to do evil things,
for instance, IPs from government organisations trying to monitor
downloading behaviour, spyware trackers, etc. Whenever your
computer tries to make any connection to one of these blacklisted
IP's, Peerguardian will prevent it and protect your computer. I
consider it a must-have for every computer using P2P applications.
Peerguardian is not (yet) available through the 2007 repositories, so
we'll have to download the source code from the main website.
http://prdownloads.sourceforge.net/peerguardian/pglinux1.5beta.tar.gz. Save this somewhere on your harddrive and unpack
the source where you want to compile it (e.g.: ~/src/pglinux).

I know a lot of you will probably say something like, “Source code??
I've never done that! HELP!!” Trust me, it's not that difficult and I will
guide you through the process.

First start Synaptic, locate the 'iptables', the 'iptables-devel',
the 'ipset' and the 'gcc-c++' packages and install them. You'll need
them to compile Peerguardian.

Now go back to your source directory and open a terminal window.
Type './configure' and type the enter key. You'll see a long list
being made of things getting checked. This process will check to see
that everything is ok and will create the configuration files needed for
the compile.
Finally the list will stop running, stating “It's ok to start your make
now”, do so by entering the 'make' command. Again there will be a
lot of gibberish in the terminal window, but if it completes you'll have
a freshly built peerguardnf-binary at the ready. As root, copy this
binairy to /usr/bin using the command 'cp -a ./peerguardnf
/usr/bin'. (Some people may say that 'make install' is a better

Installing and Using Peerguardian on PCLinuxOS
solution for installing the binary. That is absolutely correct, but for
some reason, it doesn't work. And the package is no longer being
maintained, so we'll stick to copying it instead.)

STARTING PEERGUARDIAN

There are two ways of starting Peerguardian, either automatically by
a script which will do all the work for you, or by doing things by
hand, leaving more room for configuration.

If you want to do it automatically with a script, you're lucky because
I've provided one for you. It updates the lists of blocked IP's from
bluetack.co.uk (level 1&2 blocklists) and tells you when Peerguardian
has loaded successfully (or not). You can download this script at
http://www.xs4all.nl/~dutourge/start_peerguardian. In order for the
script to work, you have to make it executable. Do so by typing the
command 'chmod a+x ./start_peerguardian' in the directory
that contains the script. Now you can just start Peerguardian by
double-clicking the script. If you wish to check whether all is going
well, you might want to take a look inside the logfile. It'll be located
under ~/.pglinux/pglog.txt.
If you want to start Peerguadian manually, here's how.

Pick up some blocklists from http://www.bluetack.co.uk. In the top
right corner there is a link 'blocklists' which will lead you to the
download page. As you can see, the IPs have been split up under
several categories, e.g.: Spyware, Level1, Addons, etc... The Level1
blocklist is the most important one, it contains the largest list with
bad IP's everyone ought to have blocked. The others are optional.

You can download one by clicking on it and agreeing to the license.
Save the *.zip file to a location of your choice. Unzip it, and you'll
find a regular textfile inside. This is useful, because if you download
multiple blocklists, you can just paste one underneath. Remember
the location of the textfile, since you need it to start Peerguardian.
Now it's time to start Peerguadian itself...

First load the ip_queue module by typing 'modprobe ip_queue', it's
needed to run Peerguardian
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As an example I'll take my regular command to start Peerguardian
(note: peerguardnf must be run as root. If you type 'peerguardnf -help' you'll get a full list of options. I'll use just a few of them in this
tutorial. ):

$ peerguardnf -d -l /home/rick/.pglinux/pglog
/home/rick/.pglinux/level1.txt

• '-d' will start the program in daemon mode, it will run as a
background application allowing you to close the terminal windows

• '-l /home/user/pglinux/pglog' will write all ouput/errors
to a logfile for later analysis
• '/home/user/pglinux/level1.txt' is the path to the
blocklist peerguardian will read 'bad IPs' from

If the loading was successful, the log will read something like this:

Reading blocklist
detected ASCII blocklist
Entering daemon mode
Blocking 140336 ranges (735355236 IP addresses)

Congratulations, you've just started Peerguardian for the first time! If
you want to stop it again, open Ksysguard and kill peerguardnf.

Use Amarok To Transfer Music Files To Your Zen
by Papawoob

Just a short How-To that took me considerable time to figure out.
Hope this saves someone from the trials and tribulations of having to
figure this out for themselves. This will only work on a 2007 install.
On .93, either Amarok, or libmtp0 was not quite there yet. You can
transfer files but, the names will all appear in Chinese characters
which, if you can read Chinese would be great I suppose but, I am not
able to read Chinese. In 2007 it works like a charm!
Open Synaptic and install "libmtp0" then close Synaptic.

Open Amarok -> Main menu ->Multimedia -> Sound -> Amarok

If this is your first time opening Amarok it will ask you some
configuration questions like where do you store your music so that it
can import it and organize it. Unless you prefer some other music
manager I would go ahead and let your music be imported.

Go to Settings -> Configure Amarok -> Media Devices ->Add Device

Fig. Add Device

You will see a window with 3 boxes like the one above. Click the
arrow to the right of the first box and choose "MTP Media Device." In
the second box enter a name for your device like "My Zen." Leave the
third box alone and then click "OK."
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Fig. Configure Amarok

You should now see it listed at the top of the Configure Amarok
window. Click "Apply" and then "OK."

You will now be back at the main window. In the bottom left corner
you should see a tab that shows the first few characters of the name
you gave your Zen (in wy case, “Devi...”). Click this and at the top
you should see a "Connect", a "Disconnect", and a "Transfer" button.
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Fig. Amarok main window

At this point you can now plug your Zen into your USB port. Next,
click "Connect" and you should see your Zen connect. If you have any
music files on your Zen they will appear in the left hand window.
Browse to the folder where you store your music and open it. Move
the two windows around so that you can see the left half of the
Amarok window and as many of your music files as possible.

Drag and drop all of the files you want to transfer to the left half of
the Amarok window. (NOTE: when you drop the first file the window
will split in half and you will see the file you dropped in the bottom
window. Continue to drop files in the bottom window until you have
everything you want to transfer.)
Next, click the "Transfer" button and you should see the files being
transferred to your Zen.
When the transfer is complete, click the "Disconnect" button and it
will now be safe to remove your Zen from the USB port.
Happy Zenning!

Installing PCLinuxOS on a Windows XP HD
by youcantoo@findmoore.net

INSTALLING PCLINUXOS ON A HARD DRIVE WITH WINDOWS
XP ALREADY INSTALLED.
Start by booting your system with the PCLinuxOS Live CD. When you
get to the log in screen, select the user name “root” with the
password also as root. Once the desk top loads, double click on the
package management (Synaptic) icon. It's the one with the red and
black circular icon at the bottom of the screen.

Once it loads, you should now see something similar to the pictures
on the next page.
Now, you want to search for and load some software that will allow
Linux to read and write to the Windows NTFS file system. At the top
of the Synaptic screen, click on the search icon. This will open the
search dialog box. In the dialog box, type in “NTFS”, and once
completed, click on the “search” button.
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Now, Synaptic will search for all the programs containing your
selected search term “NTFS”. You should see something similar to the
window below.

Now click on the little box next to the “ntfs-3g”. This will open a
dialog box as in the following picture.

Installing PCLinuxOS on a Windows XP HD
Click on the “Mark for Installation” line. This will select the “ntfs-3g”
file for installation. It now will tell us that we need to mark additional
changes. Click on the “Mark” button in the dialog box.

Now you want to apply and install the “ntfs” programs. Click on the
“apply” button at the top of the window.
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Click on the “Apply” button in the lower right corner of the dialog
box. Synaptic will now go about installing the requested software.
Once Synaptic has downloaded the software requested, it will install
the software and update PCLinuxOS. You will see a screen similar to
the following.
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Once Synaptic has finished loading your requested software, you
should see a window similar to the one which you started.

Note that the file “ntfs-3g” now has a green box proceeding it, telling
you that this software has been installed on your system. At this
point, close Synaptic, by clicking on the “X” in the little red box at the
top right hand corner of the Synaptic window. You are now back at
the desktop. Now you are going to prepare to resize your hard drive
for the Linux installation. Click on the “Konsole” icon.
Advertisement
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You should now see a “Konsole” window link as in the following
picture. In the Konsole window, type “draklive-install”, and then
press the enter/return key.
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This will start the partition/install program.

Click on the “Next button in the dialog box.

In the following window, you are going to select the hard drive on
which you want to install Linux.
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Use the default hard drive, and click the “Next” button. Make sure to
select “Use the free space on the Windows partition”. Then click on
the “Next” button.

A friendly reminder. You are about to resize your Windows partition.
You did defrag your windows drive before starting this, didn't you??
If not, you could lose all your windows setup. If you DID NOT first
defragment your Windows Drive, CANCEL now and defrag your
Windows system! Did you also backup your important files? When
you are ready, press the “Next” button in the dialog box to continue.
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Pick the partition that you want to resize. Note it is normally labeled
“hda1” and is usually the default partition. Click the “Next” button in
the dialog box.

You are now ready to do the actual resizing of the Windows partition.
Using the slider bar, select the size that you want the new windows
partition to become. To make a 20 gig Windows partition, choose
20480.
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For the following size Windows partition, use the following numbers:
10
15
20
25
30
35
40
45
50

gigabyte
gigabyte
gigabyte
gigabyte
gigabyte
gigabyte
gigabyte
gigabyte
gigabyte

hard
hard
hard
hard
hard
hard
hard
hard
hard

drive
drive
drive
drive
drive
drive
drive
drive
drive

use
use
use
use
use
use
use
use
use

10240
15360
20480
25600
30720
35840
40960
46080
51200

Use the slider bar to get close to the number you want, then use the
“left” or “right” arrow keys for finer control.

The screen shows a final warning before the resizing and formatting
takes place. Click the “Next” button in the dialog box.
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After resizing the Windows partition, Linux will then setup, format it
its own partition to use.

After formatting is completed. you will be notified that the next time
Windows is started, it will do a data integrity check first.
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Click the “OK” button in the dialog box.

Now Linux is going to install itself on your newly partitioned hard
drive.

The Linux software installation will take a few minutes depending on
the speed of your computer.
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Once Linux has installed itself on your hard drive, it will ask about
the booting options. At this point use the DEFAULT settings. Click
the “Next” button to continue.

Again, use the DEFAULT settings. Click the “Finish” button in the
dialog box.
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Now it is time to set the “ROOT” user password. Select a password
that is difficult enough that it will not be guessed, but also one that
is easily remembered by you. Remember that the root password is
part of what makes your new Linux system secure. Choose it wisely!
After entering your “root” password, click the “Next” button in the
dialog box.
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Now, it's time to add the user's names and passwords.

To change the icon, click on the icon picture. When you are finished,
click the “Accept user” button. When finished, click the “Done” button.

Congratulations, you have managed to resize your Windows hard
drive and install PCLinuxOS in a dual-boot configuration. To finish,
click on the “Finished” button in the dialog box.
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At this point, you should be back to the Live CD desktop with the
“Konsole” window open. Close the “Konsole” window by clicking the
“X” at the top right of the “Konsole” window. Now it is time to
shutdown and reboot your system. At the bottom left corner of the
desktop, click on the Linux “PC” logo. From the menu, choose
“logout” in the dialog box. Click on the “Restart Computer” button
and follow any additional instructions displayed on the screen.
After your computer restarts, you will be greeted with the Grub
loader. The default OS loaded will be PCLinuxOS. To change which
OS is loaded use the up and down arrows to select the desired OS
and than press the enter/return key. This will then boot into the OS
you selected.

Commentary
by an Anonymous Volunteer

The Internet is notorious for being extremely amorphous,
transitioning from one definitive technology to another. We've
witnessed its transformation in its various forums and services.
During the later part of the last millennium, a giant grew and built a
kingdom; and towards the turn, a (community) challenge was
heralded throughout the kingdom. Lately, this challenge is gaining
momentum as the giant acknowledges the threat of the community.

I am not a soothsayer who could foretell what will happen after the
battle, and I am not going to make presumptions. I've been wrong
quite a few times, though I've made a few logical bulls eyes as well. I
am one who would not publicly make a statement on baseless
audacity.

However, we all notice that there are exciting things happening these
days: the Novell and the Xandros pact with Microsoft; the “patent
infringements” of Linux; Dell selling Ubuntu machines; PCLinuxOS
outranking Ubuntu on the 7 and 30 days page hits at Distrowatch.
These are enchanting and unprecedented times in our history. More
so, there is a shift, and I am not referring to the migration of
Windows users to GNU/Linux. I am talking FLOSS.
Let's try to make one sensible analysis of this. We can agree that the
Internet has become the most important feature in any personal
computer. PCs request web pages; servers send the code; PCs render
the pages. It's the same with all other information and services.
Content Management Systems (CMS), from blogs to media, such as
music, videos and photos, often work on the same concept. The PCs
are the walls that the echo bounces back from.
There was a time when server stacks were considered as the main
avenue for transversing the information highway. GNU/Linux and
MacOS users have full featured servers hidden behind all the glossy,
shiny desktops. Windows users seem to be getting the backhand of
things as they struggle with vulnerabilities and security. Even so,
Windows clients can also act as servers.

PCs ... yours and mine and the millions (if not billions) of others... are
making headway in serving information and services on the very same
highway once owned by a few giants. Is this good, or is this bad?
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Change is inevitable. A sizable fraction of PC owners find themselves
with reasonably fast home connections on top of these hidden
servers on their OSes with enough power and features to get the job
done. They are beginning to realize that there is no point in paying
hosting companies the few dollars to have their websites hosted; they
can do it themselves. Many will probably read the Linux SAG.
However, there will always remain problems, especially in the security
section, and those little broken things that one has to sift though volumes of fix it readme files. None of these problems are new. Many
users can just happily live with them.
I'd like to think this is an open door for FLOSS if adequate
understanding is acquired by the users. A majority are easy to install
through GUI interfaces, and best of all, owners can exercise their
right to the freedom that accompanies these softwares.
The often misunderstood "alternative" operating system and its
communities of true freedom fighters along with its creative,
innovative, inventive arsenal of FLOSS is ready to confront any
Goliaths and, in the common belief, will stand strong as the
champion of all.

There have been many predictions about the future, and I am not the
prophet nor the One. I do know one thing though, there is a
revolution going on right now between closed and open source
software. And I have decided on my side. How about you?

How to Copy/Clone User Account in Linux
Found at http://www.ambience.sk/user-account-copy-linux

Task: Copy/clone user account, so that both users have the very
same settings in their user home directory.
Copying a user's home directory (e.g. olduser) to new user (e.g.
newuser) is easy:
1. Create new user:

adduser newuser

2. Copy all special hidden (dot) files to new user's home directory:

cp --recursive /home/olduser/.[a-zA-Z0-9]* /home/newuser
3. Copy other standard files to new user directory:

cp --recursive /home/olduser/* /home/newuser

4. Set new user's directory and files owner to new user for hidden dot
files: chown --recursive newuser:users /home/newuser/.*

5. Set new user's directory and files owner to new user for normal
files:
chown --recursive newuser:users /home/newuser/*
You are done. In some cases you may need to change user group
(users in this case).

Now logout and try to login as the new user. All the settings for the
programs should be the very same as for the old user. You can for
example compare the settings by running KDE and checking the
wallpaper and other settings of the new user. If the copying of the
user folder was successful, everything will look the same.
Advertisement:

Your Friend, The Alias, Part I
First a little history.

A short while ago, someone in the PCLinuxOS forum was asking
about apps that would allow mounting an ISO image to his desktop.
I've used such apps in the past, but recent installations, using the
latest version of my favorite one, (of the two I've used) MountISO, on
newer distro versions throws up errors that the ISO image is not
really an ISO image, or that it is corrupt. The problem seems to be
that the latest version is from Oct. 16, 2005 and needs updating.

The other is a GUI app, AcetoneISO, which will mount various
proprietary Windows burner image formats, as well. It works fairly
well, but requires a multitude of other packages to work.(1) This is all
fine and good, if one needs that functionality. However, I do not run
Windows, so my only exposure to image files of a Windows type
might be from an occasional download. For those occasional, odd
files, I still use AcetoneISO, but I find AcetoneISO to be a rather
clumsy way to mount the ISO images I do work with daily. Each
mount requires a root password, and a directory choice, as to where
the image will be mounted. This gets old rather fast, when one does
this many times a day, so I created some aliases to do the job for me,
without the hassles.
I suggested using this approach, as an alternative to AcetoneISO, in
the forum thread, with instructions on how to do so. KDulcimer, one
of the forum regulars, suggested that this might make a good article
for PCLinuxOS mag. In further conversation, I wrote:
"I can type 4 letters faster than I can right click the image and
navigate through three layers of menus.

“When file browsing with Konqueror, I usually have the terminal
emulator window open, which syncs with the navigation, and have, at
present 72 aliases for the things I most commonly do. The longest
alias is only 6 letters, most are 4, a few are only 3. Some of the
aliases are for chains of other aliases that would otherwise require a
long script, more complicated than I would know how to write. For
instance, I download an item from Usenet binaries that is in split rar
files, with par2 volumes for error correction. Both the unrar and par2
apps are command line only, and scare off a lot of users. By creating
an alias for each process, and chaining them with other aliases, a
single 5 letter entry, at the prompt, runs the par2 integrity test,
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makes the repair if it is needed, unpacks the rar volumes, and cleans
up the directory so that only the unpacked item remains. I don't have
to remember the various commands, arguments, and syntax, for
each app, only the alias. If I forget the correct alias for the process I
want, typing "alias" gives me the entire list, to remind me."
KDulcimer, responded with:

"Wow. Would you instead consider writing an article about aliases,
how to create them, potential purposes, etc? This sounds like neat
stuff."

I had already decided that would be the direction to take; Not one
article, but a series of articles that would each be a "How to achieve a
desired outcome using aliases." So as not to overwhelm the newbies,
I will take one desired outcome, or a few related and intertwined
outcomes, per article, and explain in detail why an alias would be
desired, and then the process of creating it, or them. I will create a
step by step set of directions, which the reader can implement, while
they read the article.

There are already plenty of sources for this information, but most use
boring examples, appropriate for programmers only, whereby most
newbies go "deer in the headlights" when reading, and miss the
entire point about the usefulness and simplicity of the process. They
end up with even more fear of the command line than they started
with. I hope that, by presenting the information in a real world
context, with a subject they can directly relate to, explained in
language that a normal child can follow, the process will be
demystified, and the fear dispelled.
Borrowing heavily from the forum article, as I already wrote that in
much the same manner as I intend to follow throughout the series, it
would seem appropriate that the first should be:

HOW TO MOUNT AN ISO IMAGE ON YOUR DESKTOP, AS A
NORMAL USER, USING AN ALIAS
Rules and Definitions:

I will assume the reader is using the KDE desktop, and give directions
based on that. (For those using Gnome, you will have to find any
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Gnome equivalents, if necessary, or use the KDE tools, where there
are no equivalents.)

If I write something as <something> it means that the reader
should substitute the item indicated with that which is appropriate to
him. (I refuse to follow the "politically correct" him/her/self stuff
when I write. Get over it, life's too short.)
When I say "open kwrite" for editing, if you like something else,
substitute that and use what you're comfortable with.

Alt+F2 = Press the Alt and F2 keys at the same time.
<Enter> = Press the Enter key
****** = Root's password
~/ = Your home directory

./ = This directory = PWD = Present Working Directory = The

directory which you are now in, that contains the file you wish action
upon.

* = Anything, Whatever = As used here, in the form, *.iso = Any file,
by whatever name, that ends with the extension .iso.

FYI: = For Your Information. I will use this to explain what a
command, or a file entry, does, or means.

INSTRUCTIONS:

First set yourself up as a sudoer. Alt+F2 brings up the "Run
Command" box. In the box, type;

kdesu kwrite /etc/sudoers

<Enter>

FYI: This asks the system to open the file "/etc/sudoers" with

kwrite, with the root permissions needed to write to that file. Another
box will open requesting the root password. Enter it.

******

<Enter>
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Read the file, ignore the part that says it MUST be edited with visudo,
and in the appropriate section, at the bottom, write;

<yourusername> ALL=(ALL)

NOPASSWD: ALL

where you use your own user name in the obvious place. Save the
file, and close kwrite.

FYI: You are now a sudoer, and will not be asked for a root

password each time your alias uses sudo to mount, or unmount, an
ISO image.

Next, create an empty directory on your desktop named "iso", without
the quotes. Left click your "home" icon, and from the "View" menu
select "Show Hidden Files". Open the file .bashrc with kwrite, and
copy/paste into it, this line;

test -s ~/.alias && . ~/.alias || true
Save .bashrc, and close kwrite.

FYI: This tells bash, your shell, to test for the presence of a hidden
file named .alias, in your home folder, and, if it's present, use it's
contents as if it were an integral part of .bashrc.

FYI: The command to mount an ISO image is; "mount -o loop
/path/to/<filename>.iso /path/to/<mountpoint>"
where <filename> represents the actual name of the .iso file, and
<mountpoint> is a directory name. Only root can use the mount
command, hence the use of sudo.

Next, open kwrite, again, to create a new text file, and copy/paste
these lines;

alias imnt='sudo mount -o loop ./*.iso ~/Desktop/iso'
alias umnt='sudo umount ~/Desktop/iso'
and save the file as ~/.alias.

FYI: The name of the file is ".alias" (without the quotes) and it is
saved in /home/<yourusername>
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FYI: I chose "imnt" as a unique, short form of "iso mount" to aid

remembering the alias, it's purpose, and to differentiate it from any
other command or alias. Similarly "umnt" is a unique shortened form
of "umount"

FYI: To break down the alias imnt; sudo="as root"; "mount
-o loop"="mount as if it were a block device"; ./="from this
directory"; *.iso="any file with the extension .iso";
~/Desktop/iso="to a directory named "iso" located on this users
desktop"

FYI: To break down the alias umnt; sudo="as root";
umount="unmount"; ~/Desktop/iso="whatever is mounted to a
directory named "iso" located on this users desktop"

You could just copy/paste the lines into .bashrc, but this way you
have a separate .alias file to keep them, and any other aliases you
may wish to add in the future, and don't clutter up .bashrc.

Now to use this, open the Konqueror file browser, and navigate to the
directory that contains the ISO image you want to mount. From the
"Window" menu, choose "Show Terminal Emulator", and simply type,
at the prompt;

$ imnt

Your ISO image is now mounted in the "iso" directory on your
desktop, and you can browse it to your hearts content, and copy files
from it to other directories, if you wish. Remember it's a mounted
image, of a read only file system, so you can't copy files to it, only
from it. One caveat to this working is that the ISO image you want to
mount must be the only ISO image in the directory. If you have a
directory with a number of ISO images, you must first separate them
into their own private directories, within the main directory.
To unmount the ISO image, from any terminal window type, at the
prompt;

$ umnt

Now, if you have followed the instructions, as you were reading this,
and if you have actually created and used the aliases to successfully
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mount, and unmount an ISO image, congratulations. Even if you are a
green as grass, newbie, GUI guy/gal, (I know I said I wouldn't do that.
Quit your laughing) you've learned how to accomplish a specific,
desired, repetitive type task, with a minimum amount of keystrokes,
using the dreaded command line, and it didn't even hurt. :)

In this article, I've tried to be a bit overly redundant with the
definitions, and the FYI explanations, so that even newbies (Are Linux
newbies really "gnubies"?) who are not used to command line
shortcuts, and structure, will understand that it's just a way to give a
simple instruction to the computer. An alias is used to save
keystrokes when entering those instructions. Some of the
explanations of what the syntax means might not be precisely
correct, but they convey the essence of what one is
requesting/commanding the computer to do, hopefully in a way that
also conveys why the structure is as it is.
And what, may I rhetorically ask, do we really learn from all this? An
alias is a very simple, quick, shortcut used to enter a more
complicated command. What is it's true value? Efficiency. The longer,
and more complicated the command, the more often one needs to
use it, the greater the keystroke reduction, the greater the value of
the alias.
Next time, I'll show you how to create aliases to actually accomplish
some specific useful tasks, and how to join them to accomplish
multiple tasks with a single alias.
Thus ends our lesson for the day.

AcetoneISO2 depends on the following packages :
- fuseiso, fuse-utils, libfuse2, mkisofs, libqt4-core, libqt4-gui,
konsole, konqueror, kdebase-bin, kdelibs4c2a,libfuse-dev, buildessential, cdrecord, cdrdao, dvd+rw-tools, p7zip-full, gnupg,
coreutils, libglib2.0-dev
(1)
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